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Upgrade Procedures from Version 2016 to 2018 

Before this type of installation is performed the user must backup all the wells and logs in their 
database. The HASP Key does have to be reprogrammed when a major upgrade is being 
performed. 

Export Log / Well Data 

This module allows you to export log configurations, well information and your Geology 
Dictionary. 

1.) Double click on the  Icon. Acknowledge the 
Security Information window by clicking on the 

 button. This will initiate the program 
and activate a Connect Database window. 

2.) Highlight the PGEOLOGY 2016 Metric [Microsoft 
Access Driver (*.mdb)] database and enter your 
User ID and Password in their respective fields (your 
default User ID and Passwords are both "pgeology"). 

Note: If connecting to the imperial database, highlight the PGEOLOGY 2016 Imperial [Microsoft 
Access Driver (*.mdb)] instead. 

3.) Click on the  button to complete the connection. The Open Log window will be 
shown. 

4.) Click on the  button. 
5.) Click on the File menu selection, select Import / Export and then select Export Log / Well 

from the sub-menu. Or, you can click on the  Export Log / Well button on the Toolbar. 
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6.) Click on the  button. This will activate a system message. 

 

7.) Click on the  button. This will activate a Choose Directory window. You may 
wish to create a new folder for these well. In the example an old wells folder is selected. 

 

8.) Click on the drive and directory where you wish the well data to be exported to. Click on 

the  button. This will activate the Exporting window. 

 

9.) When the export all well data is finished a System Message will be activated as shown below. 

Click on the  button. 

 

This procedure backs up all your well / log data along with the Symbols, Expansion dictionary 
and the Generic category. 

It also makes a copy of your pgeology32.ini file that includes all your favorites, window and 
toolbar selections. This is good to use if you want to keep running Version 2016 on another 
computer. Does not help much with 2018. 
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Power*Suite Major Upgrade Installation Procedure 

 
1.) Click on the Full Power*Suite Installation selection from our downloads page 

www.powerlogger.com/downloads.asp. This will activate a Submit Customer Information Page. 

 

2.) Filled in the mandatory fields and click on the  button. This will direct you to 
the download page. 
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3.) Click on the Download: “Full Power*Suite” verbiage. This will activate the download file 
PS2018Setup.exe. 

 

4.) Click on the  button and the file will be saved to your downloads folder. 

5.) Depending on your computer settings you may be asked to allow the application to Run. If 
you allow this down load to run this will activate the Power*Suite 2018 Download Installer 
shown below. 

 

6.) Click on the  button to continue. This will activate the Ready to Install Window 
shown below. 

 

7.) Click on the  button to begin the process of extracting the files. When they have 
been extracted you will be prompted with the Finished Window. 
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8.) When the files are finished extracting you will see the Click  button. This will 
begin the installation of Power*Suite 2018. If the installation does not proceed you will want to 
locate and run a file called setup.exe in the C:\PS2018SETUP\ folder. 

Power*Suite Installation Procedure 

1.) This will activate the Install Shield setup followed by the Windows Install window and the 

Power*Suite Welcome Message Window. Click on the  button. 

 

2.) This will activate the License Agreement window. Click on the  beside I accept the terms 

in the license agreement. Then click on the  button. 
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3.) This will activate the Customer Information window with User Name and Organization fields. 
In the Install this application for portion of the window Click on the  beside Anyone who 

uses this computer. Then click on the  button. 

 

4.) This will activate the Custom Setup window. There are a couple of things that can be 
initiated in this window. You can change the install folder location and you can utilize a 
second type of Power*Suite licensing. 

The floating folder allows the user to have two licensing types available. This could be a HASP 
key activation for Power*Log and a QLM or another HASP key activation for Power*Curve. 

 
5.) If you do not want to change the install location or activate the Floating folder for a second 

activation then Click on the  button. Skip ahead to step 9. 
6.) If you do need to utilize a second type of Power*Suite licensing then you will want to click 

on the Floating down arrow and select This option will be installed on the Local Hard Drive. If 
not the Skip ahead to step 9. 

The floating folder allows the user to have two licensing types available. This could be a HASP 
key activation for Power*Log and a QLM or another HASP key activation for Power*Curve. 
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7) If you need to change the install destination folder click on the  button. This will 
activate a Change current destination folder. The user can navigate to an exiting folder with 

the  button, create your own folder by the  button or type directly into the folder 
name portion of the window to create your own path. 

Note: The folder name cannot have any spaces. You can use underscore _ or dashes- to 
separate the folder name. 

 

      

8) Click on the  button. 

9) This will activate the Setup for Hasp Window. If you have a Hasp USB key and it has been 

activated for Power*Suite 2018 Click on the  button. 
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10) This will activate the Ready to Install window. Click on the  button. 

 

11) Next the user will see the Installing Power*Suite window copying files, writing to the registry, 
creating desktop icons, creating start menu folder, ODBC components etc. An example of 
this window can be seen below. 

 

12) Once the Installation has been completed the Hasp Device Driver Installation Welcome 
window will be activated. Because this is an upgrade your HASP driver has already been 

installed on your PC. Click on the  button. 
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13) This will activate a Sentinel HASP Run-time Setup message. Click on the  
button. 

 

14) This will activate another Sentinel HASP Run-time Setup message. Click on the  
button. 

 

15) The Install Wizard Completed window shown below will be activated. Click on the 

 button for the Main install. 

 

You have now successfully installed Power*Suite Version 2018. 
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HASP Key Log Upgrade Procedures 

The following are the instructions on how to update your USB HASP key. 

We have adapted our authorization from Version 3.0 onward with a Hasp USB Key. Once a 
Power*Suite program is loaded on a machine the user has simply to attach a Hasp USB key to 
the USB Port on their computer. The program is initially installed and protected by a software 
program. We have utilized a Software Authorization Program called QLM in Version 2018 

1.) Click on the  button on the toolbar and click on All Programs and select 
POWER*SUITE_2018. Then select the Hasp Update Tool selection, and then click on the 

 selection. This will activate the Hasp Key Activation window. Or in Windows 8 
/10 you will want to press the Windows key on your keypad and type Hasp Log Update and select it 
from your search. 

 

2.) Click on the  button. This will activate the open file window and locate the codes that were 
sent to you via email or other means. If you do not have email then you will have to fill in this Code field 
by hand. 

 

3.) Click on the button and the codes will then be viewed in the activation window as shown 
below. 

 
4.) Click on the  button. If done successful you will receive a system message as shown below. 

Or if unsuccessful you will receive a message such as tampering as shown below. 
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5.) Click on the  button and then click on the  button to close the window. 

Verify your USB Activation 
 

You can now use any of your authorized Power*Suite Applications which are in the 
PowerSuite_2018 Desktop Folder created during the install. Double click on the Power*Log 
(Vertical Application), Power*Curve (Horizontal Application), Power*Core (Core Application), 
Power*Steer (Steering Application) or Power*Wits (Automated Import Utility) Icons to start using 
our Power*Suite applications. 

 

1.) Open the Power*Suite_2018 desktop folder and double click on the  Icon. This will 
initiate the program and activate a Connect Database window. 

 
2.) Highlight the PGEOLOGY 2018 Metric [Microsoft Access Driver(*.mdb)] database and 

enter your User ID and Password in their respective fields (your default User ID and 
Passwords are both "pgeology"). 

3.) Click on the  button to complete the connection. The New Log window will be 
shown. 

4.) Click on the  button. 
5.) Select Show Registration, under the Help menu selection in Power*Log as shown below. 
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This will activate the Security Information window and show you the access flags on the USB key 
you just activated. The window is shown below. Yours should be similar to the one shown below. 
Flags 3, 5, and 6 indicates 2018. Flags 3, 5 and 6 will run all Power*Suite applications from 
Version 6 to Version 2018. 
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Import your Log / Well Data 
1.) Select Import, under the File menu in Power*Log / Curve or Core, and then select Log / 

Well from the sub-menu. Or, you can use the  Import button on the Toolbar. This will 
activate the Import window shown below. 

 

Note: Import the symbols (powersuitesymbols-{export date}.exp), generic category 
(genericcategories-{export date}.exp) & geological expansion dictionary (geodictionary-
{export date}.exp) exports first. Then, import your well data. 

2.) Click on the  button to browse through your drives/directories for the file(s) you 
wish to import. Note that files available for importing will have an .EXP file extension. Any of 
the files that you select will then be added to the File list. Please make sure that the files you 
wish to import are highlighted (selected), in the list prior to importing. 

Note: You are not able to select more than six wells from the Import From window successfully. 
If you have a lot of wells to import, select the first well from this window. Go through the import 
procedures outlined below 7-12. Exit the import window. Activate the Import window again and 

the default folder will be the last one you used, and then you can click on the  button and 
proceed. 

3.) The Import Log/Well window will now display the details of the file(s) to be imported. Select 
or click (highlight) the file(s) to be imported.  

Note: Use the  button to select all of the files or use the  button to select none of 
the files. Note that you can select or turnoff individual files by simply clicking on them with your 

mouse. The  button will remove the selected/highlighted files from the import list, 

but will not delete them. The  button, on the other hand, will completely erase the 
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selected/highlighted files from their directory. Once deleted, these files will no longer be 
recoverable. 

4.) Click on the  button to activate the following system message, “Do you really 
want to IMPORT the highlighted files?”. 

5.) Click on the  button to proceed with the import. 

Note: If you clicked on the  button, and the file you are importing contains the 
information from an Entire Well, the following system message will be activated, “About to 
IMPORT ENTIRE WELL data. All information associated with this well in the database will 
be OVERWRITTEN. Continue?”. 

6.) Click on the  button. 

7.) Upon completion of the import, the following system message will then be activated, “Data 
has been imported successfully.” 

8.) Click on the  button to confirm the successful import of the data. 

Power*Suite 2016 Program Removal 

Note: It is not necessary to remove Power*Suite 2016. It can be done now or later. Also it doesn’t 
have to be done at all. 

1.)  In Windows 7 or less Click on the Start menu selection, select Settings and 
select Control Panel. In Window 8 / 10 click on the Windows key on your keypad, type 
control panel in your search menu and select Control Panel to Activate the Control Panel 
Window. 

2.)  Click on the  Programs and Features selection in the Control Panel Window. 

Note: Uninstall the Updates for Power*Suite 2016 first 

 

3.)  Click on the Power*Suite_2016 program and click on the  button. 
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4.)  This will activate the Windows Installer and then a User Account Control Window. Select the 
Allow Option “I know this Program, I know where it’s from or I’ve used it before” 

5.)  This will remove the Power*Suite program. When it is finished it will remove Power*Suite 

form the list. Close the windows by clicking on the  x’s in the upper right corner 
of the windows. 


